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Squad Battles Scenario Editor 
Introduction 

The Scenario Editor can be used to create new scenarios and to modify existing scenarios for 
Squad Battles. The Editor has full support for all unit placement and modification (such as 
strength and effectiveness modification) and full support for other scenario features (such as 
objective placement). 

This manual last updated: November 7th, 2023 

Using the Editor 
When the Editor is run, it will normally prompt you for the filename of a scenario to edit.  After 
you select a scenario and click OK, the Editor will display the full-size map associated with the 
scenario (see the Initial View submenu in the Settings Menu for how to control which map 
resolution is initially displayed).  In addition, in the lower right-hand corner of the screen, the 
Editor will display the Unit Dialog which displays the units which are available to either be 
placed on the map or placed as reinforcements (see Display Unit Dialog in the Command 
Menu to redisplay the Unit Dialog if it becomes closed).  If the Prompt for Scenario option in 
the Settings Menu is not set, then the initial dialog listing the scenarios will not be shown and 
you will need to select the File New or Open menu item to create or read an existing scenario.  
Note: you do not want to modify the original scenarios distributed with Squad Battles.  You 
should make a copy of the scenario file if you want to modify an original scenario. 

At any given time, the Editor is either in Move Mode or Place Mode.  By default, the Editor is in 
Place Mode.  When in Place Mode, clicking on the map with the right mouse button causes 
the currently selected unit in the Unit Dialog to be placed on the map.  When in Move Mode, 
right clicking on the map causes the currently selected units to be moved to the selected hex.  

When in Place Mode, the cursor is displayed as a cross .  When in Move Mode, the cursor 

is displayed as a circle .  The mode of the Editor can be toggled by clicking on the Mode 
Button in the Toolbar.  Alternatively, the current mode of the Editor can be toggled by holding 
down the Control (Ctrl) key. 
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Placing and Moving Units 
The Unit Dialog displays all of the units in the Order-of-Battle that have not been placed on the 
map or placed as a reinforcement.  To place a unit on the map, first find the unit in the Unit 
Dialog and select it.  Then, ensuring that the Editor is in Place Mode, click on the hex to place 
the unit with the right mouse button.  After placement, the unit will be selected and can be 
modified relative to such factors as facing and strength by using the Command Menu or 
buttons on the Toolbar.  To move units from one hex to another on the map, select the selects 
and, ensuring that the Editor is in Move Mode, click on the hex to move the units to with the 
right mouse button.  Use Remove From Map in the Command Menu to remove unnecessary 
units from the map. 

Adding and Deleting Reinforcements 
Adding reinforcements to the current scenario is a twostep process.  First, identify the units to 
be added as reinforcements in the Unit Dialog and place them on the map at the location of 
the entry hex.  Second, after selecting all of the reinforcements that are to arrive as one group, 
select Add Reinforcement from the Units Menu.  This will display the Reinforce Dialog so that 
additional information such as the arrival time can be entered.  Having done this, the units will 
be removed from the map and a reinforcement entry will be generated for the current scenario. 

Reinforcements which have been previously defined can be reviewed, modified, and deleted 
using the Scheduled Dialog. 

Editing A/I Scripts 
A/I Scripts are used by the program to determine the movement of units when a given side is 
under Automatic A/I.  They are not used for a given side when that side is under Manual 
control. 

To make changes to the A/I Scripts associated with a scenario, you must first be in A/I 
Mode.  To enter A/I Mode, press the A/I Mode button on the toolbar or use the A/I Mode 

command in the Scripts Menu. 

An A/I Script consists of three pieces of information: 

• An organization or unit that that the script applies to. 
• An objective to be move towards. 
• A turn at which the script becomes active. 
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When you enter A/I Mode, the existing A/I scripts in the scenario are displayed on the map.one 
sides scripts are displayed in blue and the other side in red.  Each script is shown as an arrow 
from an originating location to the objective of the script.  At the objective, the turn number 
that activates the script is shown. 

While in A/I Mode, there are three changes you can make to a script: 

• Add a new script to a given organization or unit. 
• Increase the activating turn number of an existing script. 
• Decrease the activating turn number of a script, which may also delete the script. 

Adding A/I Scripts 
To add a script, you must first either Highlight an organization or select a unit.  Highlighting an 
organization can be done on the map by selecting units and then using the Highlight 
Organization command of the View Menu.  It can also be done by using the Show Organization 
command, particularly for off-map organizations that are scheduled to arrive as 
reinforcements.  If you want to issue an A/I order for a unit, select the unit on the map and 
make sure no organization is currently Highlighted 

Once you have highlighted the organization or selected the unit, you next right-click on the 
map where you want the objective of the script to be.  This will create a new A/I Script for that 
organization or unit and draw it on the map.  If this is the first A/I Script for that organization or 
unit, then the activating turn number will be 1.  Otherwise, the activating turn number will be 
one more than that last A/I Script for that organization or unit. 

Increasing the Turn Number 
You can increase the activating turn number of any script, regardless of whether an 
organization is highlighted or a unit is selected.  You right-click on the objective hex of the 
script and this will add one to the activating turn number for that script. 

Decreasing the Turn Number 
You decrease the activating turn number of an existing script by right-clicking on the 

objective hex while holding down the Control (Ctrl) key.  This will subtract one from the 

activating turn number of the script.  If the resulting turn number is either less than 1, or 
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equal to the activating turn number of the preceding script for that organization or unit, 

then the script is deleted. 

A/I Firing Scripts 
It is possible to give a unit or organization an A/I command that affects the way the unit fires 
rather than moves.  To do this, you start by issuing an A/I Script and you establish a turn 
number as you would normally.  You then right-click on the objective hex of the script while 
holding down the Alt key.  This turns the script into a Firing Script which is shown with the turn 
number in yellow and enclosed in square brackets.  A Firing Script will cause the selected unit 

or organization to fire on the designated hex through the 
specified turn, at which point the unit or units are free to 
choose other targets. 

Script Sets 
It is possible to have multiple sets of A/I scripts in a single 
scenario.  Associated with each set is a name for that script 
and a probability that the set of A/I scripts will be used when 

the scenario is played.  This provides variability when playing the scenario against the A/I as 
the player can’t be certain what the A/I will be doing. 

To create and modify A/I script sets, use 
the List A/I Scripts option of the Scripts 
Menu.  This will display the Script Dialog.   

The script set that is currently selected in 
this list is the one that is being displayed 
and edited on the map.  You can use the 
Script Dialog to initiate a new script set 
and then edit that script set as described 
in this section. 

  



Scenario Editor Help File 

8 

 

The Menus 

File Menu 
The File Menu is used to read and write scenarios from and to disk and to perform other basic 
file operations. 

New 
 to clear any scenario currently in the Editor and to begin a new 
scenario from scratch. 

Select Open to open an existing scenario.  You will be prompted for 
the filename of the scenario.  Note: you should not make changes to 
original scenarios distributed with the game software.  If you want to 
make such a change, you should copy the scenario file to a new 

filename before editing it. 

Save  
to save the current scenario to a file.  If the scenario was previously read from a file, it will by 
default be written back to the same file.  If the scenario was started from scratch, you will be 
prompted for the name of the file. 

Save As 
 to save the current scenario to a different file than the one it was previously read from.  You 
will be prompted for the new filename. 

Select Exit to exit the Editor. 

Scenario Menu 
The Scenario Menu is used to modify basic information about the current scenario such as 
scenario length and description. 

Header  
displays the Header Dialog which can be used to edit basic 
scenario values. 

Description 
 displays the Description Dialog so that the scenario 
description can be entered and modified. 

Add Support 
 To add the currently selected air or artillery units to the support for the current scenario. 

View/Delete Support 
 to display the View Support Dialog which allows air and artillery support to viewed, modified, 
and deleted. 

For Clarity Submenus are 
outlined in red 
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In some games, Rolling Barrages are supported.  
When this is the case, two additional menu options 
will appear in the Scenario Menu. 

Add Rolling Barrage 
 Displays the Rolling Barrage Dialog so that a new Rolling Barrage can be specified.  Prior to 
making this selection, you should select an artillery unit from the Order of Battle. 

View/Delete Rolling Barrages 
 Displays a dialog that lists all of the Rolling Barrages defined for the current scenario.  In that 
dialog, you can delete any Rolling Barrage you don’t want to include in the scenario. 

Command Menu 
The Command Menu is used to modify information about units that have been placed on the 
map.  Most operations in the Command Menu are applied to the currently selected units in 
the Hot Spot. 
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To Top of Stack 
 to move the currently selected units to the top of the stack. 

To Bottom of Stack  
to move the currently selected units to the bottom of the 
stack. 

Turn Clockwise 
 to turn the currently selected units one hexside in a 
clockwise direction. 

Turn Counterclockwise 
 to turn the currently selected units one hexside in a 
counter-clockwise direction. 

Toggle On Ground  
to toggle the state of the currently selected units between 
Ground Mode and non-Ground Mode. 

Toggle Hull Down 
 to toggle the Hull Down status of the selected vehicles. 

 Increase Strength 
to increase the strength of the currently selected units by 1 
man or weapon. Holding down the Alt key while selecting 
this increases the strength by 10 men or weapons. Hotkey: 
I. 

Decrease Strength 
 to decrease the strength of the currently selected units by 
1 man or weapon.  Holding down the Alt key while selecting 
this decreases the strength by 10 men or weapons.  Hotkey: 
D. 

Increase Effectiveness 
 to increase the effectiveness of the currently selected 
units by one.  Holding down the Alt key while selecting this 
increases the effectiveness by 10. 

Decrease Effectiveness  
to decrease the effectiveness of the currently selected units by one.  Holding down the Alt key 
while selecting this decreases the effectiveness by 10. 

Increase Movement 
 to increase the movement value of the currently selected units by one.  Holding down the Alt 
key while selecting this increases the movement value by 10.  Hotkey: N. 

Decrease Movement 
 to decrease the movement value of the currently selected units by one.  Holding down the Alt 
key while selecting this decreases the movement value by 10.  Hotkey: M. 
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Increase AI Fire Range 
 to increase the maximum range that a unit will fire at enemy units.  This is typically used to 
establish ambushes in a scenario and to prevent a unit from firing at excessive ranges. 

Decrease AI Fire Range 
 to decrease the maximum range that a unit will fire at enemy units. 

 Select Weapon Load 
 to display the Weapon Load Dialog so that the weapon load of the currently selected weapons 
can be selected. 

Toggle Fixed 
 to toggle the Fixed status of the currently selected units on and off. 

Toggle Disrupted 
 to toggle the Disrupted status of the currently selected units. 

Toggle Pinned 
 to toggle the Pinned status of the currently selected units. 

Toggle Demoralized 
 to toggle the Demoralized status of the currently selected units. 

Toggle Setup 
 to toggle the Setup status of the currently selected weapons.  The Setup state affects the 
effectiveness of weapons.  For more information about Setup Radios, see the Support section 
of the Users Manual. 

Toggle Gas Mask 
 to toggle the wearing of gas masks for the selected units. 

Toggle Making Smoke 
 to toggle the Making Smoke status of the currently selected vehicles.  This applies only to 
vehicles that have been flagged in the database as having the ability to make smoke. 

Make Wreck/Destroyed 
 to convert the currently selected Vehicle units to Wrecks and any selected Artillery units to 
Destroyed. 

Toggle Immobile 
 to toggle the Immobile status of the currently selected Vehicle units. 

Select Toggle Civilian to toggle the Civilian status of the currently selected units.  Note: this 
feature is not supported in all versions of the Squad Battles game series. 

Select Breakdown to convert the currently selected men or weapon units to multiple units.  
This is used when you want to disperse a given Team into smaller units. 

Remove From Map  
to remove the currently selected units from the map.  Units that are removed from the map will 
automatically reappear in the Unit Dialog for use elsewhere in the scenario (see Confirm Unit 
Removals in the Settings Menu). 

Display Unit Dialog 
 to redisplay the Unit Dialog if it has been closed for whatever reason. 
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Hexes Menu 
The Hexes Menu is used to modify values associated with map hexes such as 

fortifications and objectives. 

Add/Remove Objective 
 Displays the Set Objective Dialog so that Objectives 
can be added or removed from the current Hot Spot 
hex. 

Important: select the Owner prior to placing 
fortifications on the map.  This ownership is used to 
determine spotting of the fortifications during the 
scenario. 

Add/Clear Improved 
 to place the editor in Improved Position mode.  In this 
mode, left clicking will place Improved Positions in 
the selected hex.  Right clicking in the same hex will 
remove them. 

Add/Clear Trenches 
 to place the editor in Trench mode.  In this mode, left 
clicking will place Trenches in the selected hex.  Right 
clicking in the same hex will remove them. 

Add/Clear Mines 
 to place the editor in a mine placement mode.  In this 
mode, left clicking will place mines in the selected 
hex.  Mines are first placed as booby traps, then anti-
personnel mines, and finally as vehicle mines for 

each left click.  Right clicking in the same hex will lower the strength of the mines in that hex 
and will finally remove them. 

 Add/Clear Bunkers 
 to place the editor in Bunkers mode.  In this mode, left clicking will place Bunkers in the 
selected hex.  Right clicking in the same hex will remove them. 

Add/Clear Pillboxes 
 to place the editor in Pillbox mode.  In this mode, left clicking will place Pillboxes in the 
selected hex.  Right clicking in the same hex will remove them. 

Add/Clear Caves 
 to place the editor in Cave mode.  In this mode, left clicking will place Caves in the selected 
hex.  Right clicking in the same hex will remove them. Add/Clear Sewers to place the editor in 
Sewer mode.  In this mode, left clicking will place Sewers in the selected hex.  Right clicking in 
the same hex will remove them. 
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Add/Clear Grappling 
 to place the editor in Grappling mode.  In this mode, left clicking will place Grappling markers 
in the selected hex.  Right clicking in the same hex will remove them.  These markers placed at 
the bottom of Cliff hexsides allow movement across the hexside. 

Add/Clear Gas 
 to place the editor in a mode where left-clicking a hex will place gas in the hex while right 
clicking in the hex will remove gas from the hex. 

Add/Clear Impassible Hexes 
 to place the editor in Impassible Hex mode.  In this mode, left clicking will define the selected 
hex as Impassible.  Right clicking in the same hex will remove this condition on the hex. 

Add/Clear Destroyed Hexes 
 to add or remove Destroyed status from Trees, Jungle, Village, Town, City, or Industrial hexes. 

Add/Clear Cratered Hexes 
 to add or remove Cratered status from hexes. 

Bunker/Pillbox/Cave Facing 
 to establish a facing for the current Bunker, Pillbox, or Cave hex. 

Breastworks 
 to be able to add or remove breastworks for the current hex. 

 Shift Units on Map 
 to cause the Shift Dialog to be displayed so that the location of units on the map can be 
shifted. 

Units Menu 
The Units Menu is used to display and modify the reinforcements and Fixed unit releases in 
the current scenario. 

Scheduled 
 Displays the Scheduled Dialog which allows the list of 
reinforcements for the current scenario to be viewed, 
modified, and deleted. 

To create new reinforcements, first place the units to 
become reinforcements on the map at their entry hex.  
Adjust the facing of the units so it is appropriate for their 
entry onto the map. Select all of the units to make up a 

reinforcement group, and then select Add Reinforcement to display the Reinforce Dialog.  
This dialog will allow additional information such as the arrival time to be entered. 

Add Release 
Displays the Add Release Dialog so that Releases of Fixed units can be added to the current 
scenario. 

View/Delete Releases 
Displays the Release Dialog so that Releases can be viewed and deleted. 
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Add Withdrawal 
 Displays the Add Withdrawal Dialog so that a Withdrawal of units can be added to the current 
scenario. 

View/Delete Withdrawals 
 Displays the Withdrawal Dialog so that Withdrawals can be viewed and deleted. 

Info 
The Info Menu is used to display summary information about the current scenario such as the 
strength of on-map units and the ownership of map objectives. 

Strength 
 Displays the Strength Dialog.  This will show the total strength of all on-map units in the 
current scenario. 

Objectives 
 Displays the Objectives Dialog to see a complete list of all of the Objectives associated with 
the current scenario. 

 Locations 
 Displays the Location Dialog.  This displays a list of all the map locations. 
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View Menu 
The View Menu is used to establish display settings such as the map display resolution and 
the display of various scenario on-map data such as objectives. 

 Units Off 
 to hide the units that are currently on the map.  This is 
used when you need to see map details that are hidden by 
the units. 

 Objectives 
 to toggle the display of Objectives on the main map and 
the Jump Dialog. 

Full Screen Map 
 to toggle the display of the Hex Info Area.  When the Hex 
Info Area is hidden, more of the map is displayed. 

Map Contours 
 to toggle the display of contours on the map that show 
elevation changes.  This can be used to see elevation 
changes more clearly. 

Show Organization 
 Displays the Organization Dialog displaying the 
organizations on the map. 

Find Unit 
 Displays the Find Unit Dialog.  Using this dialog, you can find any leader or unit that is currently 
on the map. 

Jump Dialog 
 Displays the Jump Dialog which enables you to quickly go to any location on the map. 

Company Markings 
 to toggle the display of colour bars on each counter indicating the Company or other higher 
level organization the unit is associated with. 

Special Markers On Top 
 to toggle the display of special markers such as fortifications on top of the unit stack instead 
of underneath. 

Shade (opens a submenu of the view men) 
The Shade Submenu allows hexes on the map to be shaded 
according to certain criteria.  Only one option can be 
selected at a time. 

 
Visible Hexes 
 to shade all hexes that are not visible from the current Hot Spot hex. 
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Hexes In Range 
 to shade all hexes that are outside of the range of the top selected weapon. 

Command Radius 
 to shade all hexes that are outside of the Command Radius of the currently selected Leader. 

Highlight (opens a submenu of the View Menu) 
 allows units on the map to be highlighted according to certain criteria.  Only one option can be 
selected at a time. 

Fixed Units 
 to highlight all units on the map that are Fixed. 

Organization 
 to highlight all units on the map that are in the same organization as the top selected unit. 

2D Normal View 
 (Hot Key 2) Displays the map in normal size 2D graphics mode. 

2D Zoom-Out View 
 (Hot Key 1) Displays the map in reduced size 2D graphics mode. 

Normally the screen is re-centred on the Hot Spot hex when you change zoom modes.  If you 
hold down the Alt key when you change zoom modes, the screen will retain the current view. 

Settings Menu 
The Settings Menu is used to establish certain Editor settings that are preserved when the 
Editor is exited and restored the next time the Editor is run.  These options are stored in the 
Windows Registry. 

Prompt for Scenario  
option causes the Editor to display an Open dialog when it 
first starts up.  This is a quick way of selecting an existing 
scenario to edit. 

Beep on Error 
option causes the Editor to generate a beeping sound 
whenever you perform an invalid operation. 

Blink Hot Spot 
 option causes the red outline in the Hot Spot hex to blink. 

Smooth Scroll 
Causes the map to scroll smoothly from one part of the 
map to another whenever the Hot Spot  is relocated.  With 
this option turned off, the map display will immediately 
relocate resulting in faster operation. 

Auto Scroll  
Puts the map in a mode where moving the mouse cursor 
to any edge of the screen will automatically scroll the map 
in that direction.  When this option is turned off, normal 
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Windows scroll bars are displayed when the map is larger than the screen area. 

Wheel Zoom  
causes the map to zoom by using the mouse wheel. 

Hex Outlines  
causes outlines to be drawn around the hexes. 

Confirm Unit Removals  
causes the Editor to prompt before removing units from the map (see Remove From Map in the 
Units Menu). 

Complete Toolbar  
causes the Editor to display all available buttons in the toolbar regardless of screen resolution.  
Under lower screen resolutions, this will cause the toolbar to wrap thereby reducing the 
amount of space available to display the map. 

Alternative Highlighting  
causes Highlighted units to be displayed with a white outline instead of the normal red outline. 

Use NATO Symbols  
will cause infantry units to be drawn using NATO symbols in place of the soldier faces. 

 Alt Label Style  will cause map labels to be displayed using an alternative style. 

Alternate Graphics  
will cause the program to use alternate graphics files if installed.  

Initial View (A submenu of the settings menu)  

This is used to establish the initial view that is selected when the Editor is run. Three options 
are available for 2D views and two for 3D Selecting Last View causes the Editor to start in 
whatever view it was last in. 

Unit Pathfinding (A submenu of the settings menu) 

This is a tool that enables the scenario designer to establish the lowest cost legal path from 
one hex to another. To use the tool: 

• select the unit type you wish to find a path for from the sub menu 
• select an originating hex 
• press Shift + Right Mouse Button and select a destination hex 
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The three figures displayed In the destination hex indicate: 

• the range in hexes from the originating hex to the destination hex 
• The actual number of hexes that will be passed through to arrive at the destination hex 

• The total movement cost  
In the example left we can see in the destination 
hex:  R:4 /10 C: 67 this means: The range in hexes 
from originating to destination hex is 4 hexes, but 
because the unit must cross deep water via the 
bridge the actual number of hexes entered to arrive 
at the destination is 10. The total movement cost 
for that move would be 67 movement points. 

No unit needs to be selected on the map to use the 
tool, the tool works for any hex regardless of 
whether it is occupied and regardless of what unit 
occupies it. The movement cost and path 
displayed will reflect the unit type that has been 

selected on the menu. 

The path chosen will not take account of mines or obstacles if the unit involved can legally 
cross them. For example, it will plot a path directly through wire and AP minefields for infantry, 
even though they would be pinned or at risk of casualties in crossing these hexes. But It will not 
plot a path through Obstacles or deep water for wheeled or tracked vehicles because these 
hexes are impassable for them.  

This tool is makes it easier for the scenario designer to plot AI paths that will correspond with 
the number of moves that will be planned to reach the destination.  

Help Menu 
The Help Menu is used to display various help and other information about the Editor including 
this help file and copyright information. 

Select General Help to display the this help file. 

Parameter data 
Select Parameter Data to display the Parameter Data Dialog 
which shows game values specific to the current scenario. 

Weapon Data to display the Weapon Data Dialog which 
shows values for the various weapons, loads, and vehicles in 

the game. 

Select About to display various information about the Editor such as version and copyright. 
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The Dialogs 
Header Dialog 

The Header Dialog is used to modify basic information about the scenario. 

Title 
 The title of the scenario. This appears in the file selection dialogue when the main game 
module is used to open a scenario. This is different from the file name which is set using the 
“Save As” option in the file menu. 

Year, Month, Day, Hour and Minute 
The starting date and time of the scenario. 

First Side 
 The side that will have the first turn in the scenario. 

Turns 
 The number of turns in the scenario.  

Note: the number of minutes in each turn is determined by Parameter Data.  Typically, each 
turn will be 5 minutes in length. 
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Conditions 
 Determines the ground conditions during the scenario. 

Visibility  
Determines the visibility in the scenario measured in hexes. 

Background  
Determines the background sounds in the scenario. 

Asymmetric Side  
This causes the scenario to be scored using asymmetric scoring with the specific side being 
considered the weaker side. (See main user manual) 

Smoke Limit 
determines the maximum number of times that Smoke can be fired by that side during the 
scenario.   

Note: This limit does not apply to single-use weapons such as smoke grenades. 

Illumination Limit  
Determines the maximum number of times that Illumination can be fired by that side during 
the scenario. 

Chemical Limit  
Determines the maximum number of times that Chemical ordnance can be fired by that side 
during the scenario.  

Note: This limit does not apply to single-use weapons. 

Has Gas Masks 
Determines if the specified side has gas masks available for all units, or, if explicit gas masks 
are used, only those equipped with them will benefit from them 

Victory Levels 
There are four possible victory levels In each scenario. Major Defeat, Minor Defeat, Minor 
Victory, and Major Victory The values set in each of these categories are used to determine 
victory or defeat for the first side in the scenario .  

Major defeat 
If the total Victory Points are less than or equal to the Major Defeat value, then the first 
side in the scenario suffers a Major Defeat (the second side wins a Major Victory). 

Minor defeat 
If the total Victory Points are greater than the Major Defeat value, but less than or equal 
to the Minor Defeat value, then the first side suffers a Minor Defeat (and the second 
side a Minor Victory).   

Draw 
If the total Victory Points are greater than the Minor Defeat value and less than the 
Minor Victory value, then the scenario has ended in a Draw. 



Scenario Editor Help File 

21 

 

Minor Victory 
  If the total Victory Points is greater than or equal to the Minor Victory value, but less 
than the Major Victory value, then the first side has won a Minor Victory (the second 
side suffered a Minor Defeat).   

Major Victory 
Finally if the total Victory Points is greater than or equal to the Major Victory value, then 
the first side has won a Major Victory (and the other side has lost a Major Defeat). 

Banzai limit 
In games that use Berserk tactics ( also called / Fanatical, Banzai, Human wave tactics) the 
Header Dialog will display a value that limits.  the maximum number of Berserk Charge 
attempts that the side can make in the scenario. 

Mine Limit 
In games where the remote delivery of mines using artillery or aircraft is applicable this 
determines the maximum number of times that ordnance can be used by that side during the 
scenario (Note: this does not affect mines placed on the map initially in the scenario). 

Description Dialog 
The Description Dialog is used to edit the scenario description associated with each 
scenario. 

 

This description is displayed by Scenario Selection Dialog.  The description is used to describe 

historical background information about the scenario.  The Author field is displayed so that the 
name of the scenario author can be entered and modified. 

Entering the backslash character (\) into the text will cause a line break to occur in the 
description when it is displayed by the main program in the File Selection Dialog. 
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Unit Dialog 
The Unit Dialog displays the units which have not been either placed on the map or placed in a 
reinforcement in the current scenario. 

Under Available Organizations is an organization tree showing all the units not yet placed on 
the map or placed as reinforcements.  This organization tree uses the standard Windows Tree 
Control and may be navigated in a standard manner (see your Windows documentation for 
information on this interface). 

To place a unit on the map, it must first be found 
and selected.  The picture to the right shows how 
the Unit Dialog appears when an individual unit has 
been selected, in this case 1st Section 1/1.  Most 
often, you will select individual teams, leaders, or 
vehicles for placement on the map.  Higher level 
organizations such as Divisions and Corps must be 
placed one unit at a time.  Once you have selected 
the unit to place and ensuring that the Editor is in 
Place Mode (see Placing and Moving Units), click on 
the placement hex using the right mouse button.  
This will place the unit on the map, remove the unit 
from the organization tree, and automatically select the next unit in the tree.  Note that when 
you place a Team or Leader on the map, all weapons associated with that Team or Leader are 
automatically placed with that unit. 

If you inadvertently or otherwise close the Unit Dialog, it can be reopened by selecting Display 
Unit Dialog from the Command Menu. 

 

Set Objective Dialog 
The Set Objective Dialog is used to place or remove Objectives in the current Hot Spot hex. 
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To establish the current Hot Spot hex as 
an objective hex, select a nation as the 
Objective owner and assign a value and 
type to the Objective.  To delete an 
Objective, assign it the nation None. 

Objectives have a type which determines 
how they award points.  They objective 
types are: 

Normal  
– These objectives have a fixed value and 

are owned by the last side to occupy their hex.  When the objective is owned by the first side in 
a scenario, then that side is awarded points.  Normal Objectives can change ownership any 
number of times during a scenario. 

Exit  
 The value of these objectives starts at 0 and then increases each time units of the owning side 
are removed from the map at that hex.  Normally an Exit Objective should only be placed on 
the boundary of the map.  Exit Objectives cannot change owners.  Exit Objectives award points 
to the side that owns them. 

Capture  
 These objectives begin uncaptured and owned by the given side.  If they are occupied by the 
opposing side, then they become owned by that side and their points are awarded to that side.  
After they are captured, the owning side does not have to occupy the hex to get the points.  
Capture Objectives cannot be recaptured or change back to the original owner. 

Collateral  
 These objectives can award points to the owning side when enemy fire affects the hex they are 
in or when they are occupied by enemy forces on the ground and friendly fire affects the hex.  
Collateral Objectives do not change side  

Unknown Objectives 
Objectives can also be flagged as Unknown.  When an objective is unknown, it is not visible to 
the opposing side (under Fog-of-War) unless it is occupied by units from that side.  Unknown 
Normal, Exit, Capture, and Collateral objectives are called Hidden, Escape, Cache, and 
Hiding objectives respectively.  Unknown Collateral Objectives become revealed when they 
receive affecting fire. 

(For more detailed information about objective hexes see the Main User Manual.) 
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Reinforce Dialog 
The Reinforce Dialog is used to define certain data associated with a reinforcement in the 
current scenario. 

The Year, Month, Day, Hour, and Minute selections are used to establish the arrival date for 
the reinforcement.  The Probability value is the probability, in percent from 1 to 100, that the 
reinforcement will arrive at the exact arrival date.  If the probability is 100, then the 
reinforcement is guaranteed to arrive at the exact arrival date.  Otherwise, the probability is 
used to determine if the reinforcement will arrive at the arrival date, and if not, that it will arrive 
at each subsequent turn until it is determined to have arrived.  The Location is the hex 
coordinates of the arrival hex.  The Scatter value is used to determine the possible distance 
the reinforcements may arrive from the Location hex.  The Protection value is an artificial 
value introduced into the game to protect the reinforcement from enemy units that are 
crowding the arrival hex.  If the Protection value is non-zero, then at the moment the 
reinforcement arrives, two effects occur: 

1. Any enemy units within a distance from the arrival hex of one less than the Protection 
value are automatically Demoralized. 

2. Any enemy units located in the arrival hex are displaced to an adjacent hex if possible. 
Typically Protection values are used to protect reinforcements arriving on normal roads, while 
this value is set to 0 for reinforcements arriving in amphibious or airborne landings. 

It is possible to add additional arrival hexes in 
additional to the default location and to associate 
probabilities with those alternate arrival locations.  
Click on Add Alternate to display a dialog that allows 
you to enter this alternate location and a probability 
associated with it. 

In this dialog, enter the location as a pair of hex 
coordinates separated by a space.  Enter the probability as a value between 1 and 100 
representing the percentage chance of this location being used.  The sum of all probabilities 
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associated with alternate arrivals should be less than 100.  The difference between 100 and 
this sum is the probability that the default location will be used.  Click on Del Alternate to 
delete the currently selected alternate arrival in the list. 

Scheduled Dialog 
The Scheduled Dialog can be used to view, modify, and delete the reinforcements defined for 
the current scenario. 

The Scheduled Dialog displays a list of reinforcements scheduled to arrive in the current 
scenario.  Each reinforcement in general consists of several units.  Clicking on a reinforcement 
scrolls the map to the arrival hex.  Clicking on Delete will delete the selected reinforcement 
and return the units in the reinforcement to the arrival hex.  Clicking on Modify will display the 
Reinforce Dialog allowing the selected reinforcement to be modified. 

Double clicking on a reinforcement entry displays a list of the individual units in that 
reinforcement. 

Release Dialog 
The Release Dialog is used to view and delete existing Releases in the current scenario. 
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The Release Dialog displays a list of the Fixed unit releases in the current scenario.  Each 
release shows a time, date, probability that the release will occur on that time and date, and 
the organization the release applies to.  When the probability is followed by the letter T, it 
indicates that the release can also be triggered whenever a unit in the specified organization 

becomes spotted. When an asterisk (*) precedes the release, it indicates that the release did 
not occur on the time and date specified.  Selecting a Release entry will cause the organization 
to which the Release applies to be Highlighted on the map.  Double clicking on an entry also 
causes the dialog to be closed.  Clicking on Delete will delete the selected Release. 
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Add Release Dialog 
The Add Release Dialog is used to define a Release for Fixed units. 

Find the unit or organization that the Release applies to in the Organizations Tree Control (this 
control has the same interface features as the Unit Dialog).  A Release may be applied to any 
unit or organization in the Order of Battle.  The Year, Month, and Hour selections are used to 
establish the date of the Release.  When the Is Triggered check box is selected, it indicates 
that the Release can also be triggered whenever a unit in the organization spots an enemy unit.  
The Probability value is the percent chance, between 1 and 100, that the Release will occur on 
the exact Release date.  If the Probability is not 100, then the Probability is used on each turn 
starting with the Release date to determine if the Release occurs on that turn.  For example, if 
the Release probability is 50, then there is a 50% chance the Release will occur on the exact 
Release date.  If it does not occur on the Release date, then there is a 50% chance it will occur 
on the next turn, and so on for each turn until it is determined to have occurred.  If the 
Probability is 0, then the Release automatically is considered Triggered. 
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Strength Dialog 

The Strength Dialog is used to display the total strengths of all on-map units. 

The strengths of all units of each side are displayed by the various levels, Division, Brigade, 
etc. that make up each side.  The strengths are listed in terms of men, leaders, weapons, and 
vehicles.  The strength totals include all on-map units, all units scheduled to arrive as 
reinforcements. 

Objectives Dialog 
The Objectives Dialog is used to display a complete list of all of the Objectives associated 

with the current scenario and their 
assigned owner. 

Each Objective is listed with owner, 
location in hex coordinates, and value.  
Selecting an Objective will scroll the map 
to the Objective location.  Double-clicking 
on a selection will also close the dialog.  
Note: an Exit Objective will initially be 
shown with value 0 and will increase in 
value as units of the owning side are 
removed from the map at that location. 

Location Dialog 
The Location Dialog is used to display a list of all the map locations and to allow going directly 
to any of these locations. 
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Each map location is listed with its label description and hex coordinates.  Selecting a location 
causes the map to scroll to the location’s hex coordinate.  Double clicking on a location also 
causes the dialog to be closed. 

Jump Dialog 
The Jump Dialog displays a reduced version of the entire map and allows the user to jump 
directly to any part of the map.The visible on-map units are displayed on the reduced map 

using blue squares for Allied units and red squares for Axis units.  The visible portion of the 
map is shown using a red rectangle. Minefields that are currently visible are shown on the map 
as small gray rectangles.  When the Objectives option of the View Menu is set, then Objectives 
are shown as yellow squares.  The current Hot Spot hex is shown as a red outline square.  
Clicking on the reduced map area causes the dialog to be closed and the regular map to scroll 
to the selected location. 

When the Objectives option of the View Menu is set, then Objectives are shown as yellow 
squares. 
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Organization Dialog 
The Organization Dialog is used to highlight an organization on the map. All organizations in 
the Order of Battle are displayed in a Windows Tree Control.  Selecting an organization causes 

the on-board units in that organization to be Highlighted.  Clicking OK closes the dialog while 
keeping the organization highlighted on the map.  Clicking Cancel closes the dialog and 
cancels the highlighting. 

Find Unit Dialog 
The Find Unit Dialog can be used to find any given unit or organization that is on the map. 

Enter the name to be searched for in the Enter search field.  Note: the search is case-sensitive 

so you must enter your name with the proper capitalization (Marine not marine for example).  If 
you are confident that your search will produce a single result, you can hit return after typing 
the search name.  Otherwise, click on the Search button.  This will display a list of results in 
the Search results list.  Select the result you want and click on OK, or double click on the 
result you want, to close the dialog and find the result.  In the case of an organization, the 
organization will be Highlighted on the map.  In the case of an individual unit, the map will be 
scrolled to the unit’s location on the map. 
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Parameter Data Dialog 
The Parameter Data Dialog displays the Parameter Data associated with the current 
scenario. 

The Parameter Data Dialog consists of a text listing of the scenario values.  The values are 

read from the PDT file corresponding to the current scenario. (See main user manual for 
detailed explanations for each item) 

Shift Dialog 
The Shift Dialog is used to shift units on the map from one location to another. 

The Shift Dialog allows you to enter X and Y values to shift units 
on the map.  A unit at coordinates (A, B) will end up at 
coordinate (A+X, B+Y) after the shift.  The shift values can be 
positive, zero, or negative.  Positive X values move the units to 
the right while negative X values move them to the left.  Positive 
Y values move the units down while negative Y values move 
them up.  Associated map data such as the location of 
objectives, supply sources, and fortifications are also shifted.  

Units or other data that is shifted beyond the boundaries of the map are deleted from the 
scenario.  Reinforcement arrival locations are shifted, but in this case, if the location ends up 
outside the map, the reinforcement is retained at the limit of the map boundaries. 
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View Support Dialog 
The View Support Dialog allows you to view and modify air and artillery support associated 
with the current scenario. 

The View Support Dialog displays the available support for the current scenario.  Selecting an 
entry and clicking on Delete will delete that entry from the list.  Clicking on Increase will 
increase the number of units associated with that support, while clicking on Decrease will 
decrease the number of units associated with that support. 

Support Dialog 
The Support Dialog allows parameters associated with a support entry to be defined. 

When a new support entry is defined for the current scenario, the Support Dialog allows the 

delay and number of missions to be defined for that support. 

• The Minimum Delay determines the minimum number of turns that must elapse after 
the support is called before it becomes available. 
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• The Maximum Delay determines the maximum number of turns that must elapse after 
the support is called before it becomes available. 

• The Number value determines the number of that type of support available in the 
support entry.  For example, if the support type is an aircraft and the number is 3, then 3 
of that aircraft will be associated with the support entry and will take part in each 
support attack using that entry.  This value may be modified after the support is added 
using the View Support Dialog. 

• The Missions value determines the number of times that support can be utilized in the 
current scenario. 

• If the Available First Turn option is checked, then the support will be available the first 
turn of the scenario without having to be called. 

• If the Random Support option is checked, then the support will appear randomly 
during the scenario without being called and will attack enemy units in a random 
manner.  When this option is checked, then only the Number and Missions values are 
used. 

Weapon Data Dialog 
The Weapon Data Dialog displays data associated with weapons, vehicles, and weapon 
loads. 

The Weapon Data Dialog has three areas of display. 

In the Load Data, information about various weapon loads is displayed including: 

• Lethality – the lethality of the load. 
• Penetration – the penetration value of the load. 
• Eff Range – the maximum effective range. 
• Min Range – the minimum range. 
• Exp Radius – the effective explosive radius.  All units within this distance of the target 

location will be affected. 
• Exp Length – in the case of directional weapons such as Napalm, this indicates the 

number of hexes affected from the target location. 
• Reliability – the reliability of the load. 
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• Flags – including I for Indirect Fire capable. 
In the Weapon Data, information about various weapons is displayed including: 

• Assault – the value of the weapon when used in an assault. 
• Reliability – the reliability of the weapon. 
• Crew – the crew requirements for the weapon. 
• Flags – flags indicating weapon abilities. 
• Loads – a list of valid loads for this weapon. 

In the Vehicle Data, information about various vehicles is displayed including: 

• Armor – the armour protection of the vehicle. 
• Crew – the number of crew in the vehicle. 
• Speed – the movement allowance of the vehicle per turn. 
• Capacity – the number of men that can be carried by the vehicle. 
• Stacking – the men-equivalent of the vehicle for stacking purposes. 
• Reliability – the reliability of the vehicle in terms of breaking down. 
• Flags – various flags that indicate vehicle capabilities. 
• Weapons – a list of weapons carried on-board the vehicle. 

Weapon Load Dialog 
The Weapon Load Dialog allows the load currently associated with a weapon to be changed. 

The Weapon Load Dialog lists all the valid loads for the currently selected weapon.  Selecting 

from the list and clicking on OK selects that load for the weapon. 

There are some suffixes that appear based on the type of load: 

• (Smoke) indicates that the load produces Smoke. 
• (Illum) indicates that the load produces Illumination. 

If a load name is preceded by an "X", then it indicates that the load is not valid in the current 
scenario because of either the Smoke or Illumination Limit for that side. 

Withdrawal Dialog 
The Withdrawal Dialog allows any Withdrawals associated with the current scenario to be 
view or deleted. 
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The Withdrawal Dialog lists all the Withdrawals associated with the current scenario.  They 

are listed by the turn they first become effective, the probability of them occurring, the side 
they affect, and the specific organization they affect.  Clicking on an entry will highlight the 
affected organization.  Double-clicking will further close the dialog. 

 

Add Withdrawal Dialog 
 The Add Withdrawal Dialog allows a new Withdrawal to be added to the current scenario. The 
Add Withdrawal Dialog displays the organizations associated with the current scenario.  

Selecting one from this display defines the organization the Withdrawal will affect.  You enter 
the first turn the Withdrawal becomes effective and the percentage probability in the edit fields 
provided.  Beginning with the specified turn, all units in the specified organization will be 
automatically withdrawn from the map based on the probability given. 

Rolling Barrage Dialog 
The Rolling Barrage Dialog allows you to specify a new Rolling Barrage in games that support 
this feature. 
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The Rolling Barrage Dialog has fields for the Starting Date, Ending Date, Start Line, End Line, 
as well as two fields that determine the intensity of the barrage. 

In the Starting Date field, enter the date that the Rolling Barrage should start.  In the Ending 
Date field, enter the date that the Rolling Barrage should end. 

You enter the Start Line and End Line of the barrage in their respective fields.  Each line 
consists of two points that define the end points of the line.  Each point consists of two values, 
an X and a Y coordinate.  When the barrage is executed in the scenario, the barrage will consist 
of aim points distributed randomly along the start line.  As time progresses, the aim line will be 
advanced towards the end line so that it finally arrives at the end line at the Ending Date. 

The Number and Count fields determine the intensity of the barrage.  In each turn, there will 
be Number times Count hits of the weapon used when specifying the barrage.  For the number 
of times specified in Count, a new aim point will be determined along the current aim line.  
Then for the number of times specified in Number, a shot of the weapon will be determined 
using the standard scatter algorithm. 
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Other Features 
Toolbar 
The Editor has a Toolbar which exists at the top of the Editor window just under the Menu Bar.  
Note: depending on your screen resolution, only some of these buttons may be displayed on 
your screen.  You need a screen width of at least 1024 before all the buttons are displayed 
unless you have selected the Complete Toolbar Option.  Note that almost all these buttons 
implement a menu selection, and the command may be issued as a menu selection when the 
button is not displayed. 

 

 Mode 
Toggles the Editor mode between Place Mode (when pressed) and 
Move Mode (when unpressed). 

 New 
Clears any existing scenario data and starts a new scenario from 
scratch. 

 Open Opens an existing scenario file 

 Save 
Save current scenario under existing filename or prompt for filename 
if none. 

 Anticlockwise Turn the selected units anticlockwise. 

 Clockwise Turn the selected units clockwise. 

 Ground Mode 
Toggle the selected units between Ground Mode and non-Ground 
Mode. 

 To Top Move selected units to top of stack 

 To Bottom Move selected units to bottom of stack. 

 
Increase 
Strength 

Increase the strength of the selected units.  Holding the alt key while 
pressing this button increases the strength by 10. 

 
Decrease 
Strength 

Decrease the strength of the selected units.  Holding the alt key while 
pressing this button decreases the strength by 10 

 
Increase 
Effectiveness 

Increase the effectiveness of the selected units.  Holding the alt key 
while pressing this button increases the effectiveness by 10. 

 
Decrease 
Effectiveness 

Decrease the effectiveness of the selected units.  Holding the alt key 
while pressing this button decreases the effectiveness by 10. 

 Fixed Toggle the Fixed state of the selected units. 

 Remove Remove selected units from map. 

 Select Load 
Display the Weapon Load Dialog so that the Load for the currently 
selected weapons can be set. 

 Set Objective 
Display the Set Objective Dialog so that an Objective can be set or 
deleted in the current Hot Spot hex. 

 Breakdown Breakdown a unit into two subunits. 
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 A/I Mode 
Activate A/I Mode so that A/I Scripts can be added and deleted from 
current scenario. 

 
Toggle 
Improved 

Toggle Improved Position add or clear mode where Improved 
Positions are added by clicking with the left mouse button and 
removed by clicking with the right mouse button. 

 Toggle Trench 
Toggle Trench add or clear mode where Trenches are added by 
clicking with the left mouse button and removed by clicking with the 
right mouse button. 

 
Add/Clear 
Mines 

Toggle Mine add or clear mode where Mines are added by clicking 
with the left mouse button and removed by clicking with the right 
mouse button. 

 Toggle Bunker 
Toggle Bunker add or clear mode where Bunkers are added by 
clicking with the left mouse button and removed by clicking with the 
right mouse button. 

 Toggle Pillbox 
Toggle Pillbox add or clear mode where Pillboxes are added by 
clicking with the left mouse button and removed by clicking with the 
right mouse button. 

 Zoom In 

Increase the scale of the map. Normally the screen is recentred on 
the hot spot hex when you change zoom modes.  If you hold down the 
alt key when you change zoom modes, the screen will retain the 
current view. 

 Zoom Out 

Decrease the scale of the map. Normally the screen is recentred on 
the hot spot hex when you change zoom modes.  If you hold down the 
alt key when you change zoom modes, the screen will retain the 
current view. 

 Units Toggle the display of units on the map. 

 Objectives Toggle the display of objectives on the map. 

 Visible Hexes Toggle the display of hexes visible from the current Hot Spot hex. 

 Contours Toggle the display of elevation contours on the map. 

 Jump Dialog 
Display the Jump Dialog so you can quickly go to another part of the 
map. 

 
Highlight 
Fixed 

Toggle the Highlight of Fixed units. 

 
Highlight 
Organization 

Toggle the highlight of all units in the same organization as the top 
selected unit.  Holding the Alt key while pressing this button causes 
the next higher organization to be highlighted. 

 General Help Display this help file. 
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Hot Keys 
The following Hot Keys are supported in the Editor.  Note that these Hot Keys are defined as 
command accelerators of the Editor main window and therefore the Editor main window must 
have the keyboard focus for these to work (that is, the Editor main window must have a 
highlighted title bar). 

 

Shift key Display the on-map labels. 
F1 Invoke general help (display this help file). 

D Decrease the strength of the selected units by 1.  If you hold down the alt key 
while pressing this key, then the strength is decreased by 10. 

E Increase the effectiveness of the selected units by 1.  If you hold down the alt 
key while pressing this key, then the effectiveness is increased by 10. 

F Decrease the effectiveness of the selected units by 1.  If you hold down the alt 
key while pressing this key, then the effectiveness is decreased by 10. 

H Toggle display of maximum range of selected weapon. 

I Increase the strength of the selected units by 1.  If you hold down the alt key 
while pressing this key, then the strength is increased by 10. 

J Display the jump dialog. 
L Turn the selected units Left (anticlockwise). 

M Decrease the movement value of the selected units by 1.  If you hold down the 
alt key while pressing this key, then the movement value is decreased by 10. 

N Increase the movement value of the selected units by 1.  If you hold down the 
alt key while pressing this key, then the movement value is increased by 10. 

O Highlights the organization for the selected unit. 
R Turn the selected units right (clockwise). 
S Shade visible hexes from the current hot spot. 
V Display company markings on unit counters. 
X Remove the selected units from the map. 
Z Toggle Fullscreen mode. 

1 
Display the map in zoom-out 2d mode. Normally the screen is recentred on the 
hot spot hex when you change zoom modes.  If you hold down the alt key when 
you change zoom modes, the screen will retain the current view. 

2 
Display the map in normal 2d mode. Normally the screen is recentred on the hot 
spot hex when you change zoom modes.  If you hold down the alt key when you 
change zoom modes, the screen will retain the current view. 

Keypad 0 Change the ground mode of the selected units. 
Keypad 1 Move the selected units down and to the left one hex. 
Keypad 2 Move the selected units down one hex. 
Keypad 3 Move the selected units down and to the right one hex. 
Keypad 4 Turn the selected units counterclockwise. 
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Keypad 5 Toggle the fixed state of the selected units. 
Keypad 6 Turn the selected units clockwise. 
Keypad 7 Move the selected units up and to the left one hex. 
Keypad 8 Move the selected units up one hex. 
Keypad 9 Move the selected units up and to the right one hex. 

 
 


